
MC1-MK
Master Control Switcher

Operation Manual



MC1-MK Operation Manual
• Ross Part Number: MC1MKDR-004B-04

• Release Date: October 22, 2012.

The information in this manual is subject to change without notice or obligation.

Copyright

© 2012 Ross Video Limited. All rights reserved.

This work is proprietary and confidential to Ross Video Limited, its subsidiaries and its other 
affiliated corporations and may not be copied, distributed, sold or otherwise used or relied upon 
without the express written permission of Ross Video Limited. Reproduction or reverse 
engineering of copyrighted software is prohibited.

Patents

This product is protected by the following US Patents: 4,205,346; 5,115,314; 5,280,346; 
5,561,404; 7,304,886; 7,508,455; 7,602,446; 7,834,886; 7,914,332. This product is protected by 
the following Canadian Patents: 2039277; 1237518; 1127289. Other patents pending.

Notice

The material in this manual is furnished for informational use only. It is subject to change without 
notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited 
assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Trademarks

•  is a registered trademark of Ross Video Limited.

• Ross, ROSS, ROSS®, and MLE are registered trademarks of Ross Video Limited.

• openGear® is a registered trademark of Ross Video Limited.

• DashBoard Control System™ is a trademark of Ross Video Limited.

• Comtrol, and DeviceMaster are trademarks of Comtrol Corporation.

• Dolby® is a registered trademark of Dolby Laboratories.

• SanDisk® and CompactFlash® are registered trademarks of SanDisk Corporation, 
registered in the United States and other countries.

• All other product names and any registered and unregistered trademarks mentioned in 
this manual are used for identification purposes only and remain the exclusive property of 
their respective owners.



Important Regulatory and Safety Notices to Service Personnel
Before using this product and nay associated equipment, refer to the “Important Safety 
Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy 
certain regulatory compliance requirements. Notices have been included in this publication to call 
attention to these specific requirements.

Symbol Meanings       

Important Safety Instructions         

This symbol on the equipment refers you to important operating and maintenance (servicing) 
instructions within the Product Manual Documentation. Failure to heed this information may 
present a major risk of damage to persons or equipment.

Warning — The symbol with the word “Warning” within the equipment manual indicates a 
potentially hazardous situation, which, if not avoided, could result in death or serious injury.

Caution — The symbol with the word “Caution” within the equipment manual indicates a 
potentially hazardous situation, which, if not avoided, may result in minor or moderate injury. It 
may also be used to alert against unsafe practices.

Notice — The symbol with the word “Notice” within the equipment manual indicates a 
potentially hazardous situation, which, if not avoided, may result in major or minor equipment 
damage or a situation which could place the equipment in a non-compliant operating state.

ESD Susceptibility — This symbol is used to alert the user that an electrical or electronic 
device or assembly is susceptible to damage from an ESD event.

Caution — This product is intended to be a component product of the DFR-8300 series 
frame. Refer to the DFR-8300 Series Frame User Manual for important safety instructions 
regarding the proper installation and safe operation of the frame as well as its component 
products.

Warning — Certain parts of this equipment namely the power supply area still present a 
safety hazard, with the power switch in the OFF position. To avoid electrical shock, disconnect 
all A/C power cords from the chassis’ rear appliance connectors before servicing this area.

Warning — Service barriers within this product are intended to protect the operator and 
service personnel from hazardous voltages. For continued safety, replace all barriers after any 
servicing.                                                                                                                                                
This product contains safety critical parts, which if incorrectly replaced may present a risk of 
fire or electrical shock. Components contained with the product’s power supplies and power 
supply area, are not intended to be customer serviced and should be returned to the factory for 
repair. To reduce the risk of fire, replacement fuses must be the same time and rating. Only use 
attachments/accessories specified by the manufacturer.



EMC Notices

United States of America
FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at their own 
expense.  

CANADA

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of 
CE Directive 93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and 
A2:2002, and found to comply with the limits for a Class A Digital device.  

Maintenance/User Serviceable Parts

Routine maintenance to this openGear product is not required. This product contains no user 
serviceable parts. If the module does not appear to be working properly, please contact Technical 
Support using the numbers listed under the “Contact Us” section on the last page of this manual. 
All openGear products are covered by a generous 5-year warranty and will be repaired without 
charge for materials or labor within this period. See the “Warranty and Repair Policy” section in 
this manual for details.

Warning — This product includes an “Ethernet Port” which allows this product to be 
connected to a local area network (LAN). Only connect to networks that remain inside the 
building. Do not connect to networks that go outside the building.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video 
Limited could void the user’s authority to operate this equipment.

Notice — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.



Environmental Information

The equipment that you purchased required the extraction and use of natural 
resources for its production. It may contain hazardous substances that could 
impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate 
take-back systems. These systems will reuse or recycle most of the materials from your 
end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed out wheelie bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration.

You can also contact Ross Video for more information on the environmental performance of our 
products.
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Ross Video Limited Ross Video Incorporated

8 John Street P.O. Box 880

Iroquois, Ontario, K0E 1K0 Ogdensburg, New York

Canada USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
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After Hours Emergency: (+1) 613 • 349 • 0006
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On Air Control Overview

In This Chapter
This chapter provides a basic introduction to the MC1-MK, including an overview of the different 
areas of the On Air Control interface, using the menu system, as well as a brief summary of how 
video is controlled by the MC1-MK.

The following topics are discussed:

• Navigating to the On Air Control Interface 

• Menu System Basics 

• Switcher Basics 
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Navigating to the On Air Control Interface
This section provides a brief overview of navigating the MC1-MK interface in DashBoard.

To launch DashBoard

1. Ensure that you are running DashBoard software version 5.0.0 or higher. The software 
and DashBoard User Manual are available from the Ross Video website.

2. Launch DashBoard by double-clicking its icon on your desktop.

3. Locate the MC1-MK in the Basic Tree View of DashBoard. If the card does not appear, 
consult the MFC-8300 Series User Manual and DashBoard User Manual.

To access the MC1-MK On Air Control interface

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard. 

To set the MC1-MK On Air Control interface to full-screen

1. Press Shift+F11 to display the interface in full-screen mode. You can also select 
Window > Full Screen from the DashBoard toolbar.

2. To exit out of full-screen mode, press Shift+F11 again.

To lock the MC1-MK interface

1. To lock the interface, select the Lock button located in the upper right corner of the On 
Air Control interface. You can also press Shift+F4.

2. To unlock the interface, use the provided Unlock spinner.
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Menu System Basics
The On Air Control interface enables you to set up and perform transitions, configure keyers, 
monitor and control audio levels. This section provides a brief overview of the controls available 
in this interface.

Figure 1.1  MC1-MK — On Air Control Interface

1. Channel Select Buttons 

This area includes buttons that allow you to toggle between multiple MC1-MK interfaces. 
Selecting a button displays the corresponding MC1-MK On Air Control interface in DashBoard. 
A lit button indicates that the corresponding On Air Control interface is the currently (active) one 
in DashBoard. The icons on these buttons can be changed as described in the MC1-MK 
Installation Manual.

By default, and after a factory default reset is performed, these buttons do not display an icon (the 
button faces are blank).

2. Setup Tabs 

The tabs located near the top left of the interface provide options for configuring the keyers, 
on-air controls, and selecting logo channel sources. Refer to the chapter “Appendix A. 
DashBoard Menus” on page 6-1 for a list of the tabs and parameters available.

3. Audio Meters 

The On Air Control interface displays an audio meter for the first eight audio channels of 
Program and Preset (note that display will not be real-time). The meter scale ranges from 0 to 
-120dBFS. Refer to the section “Audio Features” on page 4-2 for details.

1) Channel Select Buttons 5) Crosspoint Buses 9) ATMN Button

2) Setup Tabs 6) Transition Area 10)PGM Audio Area

3) Audio Meters 7) Keyer Area 11) Lock Button

4) Timer Display 8) FTB Button
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4. Timer Display 

This display is a free running timer that counts to a maximum of 23:59:59 (hh:mm:ss) and can be 
reset to 00:00:00 using the Reset button. 

5. Crosspoint Buses 

This area is used to select the video sources for each bus. Each crosspoint button will display the 
name of its source on the button face. The last button of the row is a Shift button, which provides 
access to 10 additional selectable crosspoints. The default bus mapping is outlined in the 
MC1-MK Installation Manual. The following buses are available:

• Program Bus — The Program Bus is used to select the video source that will show as the 
Background on the Program output. After performing a factory default reset, the first 
unshifted router source (Router 1) is selected on this bus.

• Preset Bus — The Preset Bus is used to select the video source that is visible on the 
Preview output. After performing a factory default reset, the second unshifted router 
source (Router 2) is selected on this bus.

6. Transition Area 

This area provides the options for selecting transition rates (slow, medium, fast), and type (take, 
fade-fade, take-fade, mix, and fade-take). Refer to the chapter “Transitions” on page 3-1 for 
details.

7. Keyer Area 

This area includes the four keyers that place a key “downstream” of the MC1-MK system output. 
This “top level” effect can consist of a logo channels and/or character generator text. Note that the 
last Keyer is automatically assigned to an EAS source when used (EAS is enabled in the Remote 
Control tab).

8. FTB Button 

Use this button to fade the Program bus to black. The FTB rate is specified in the Home tab. After 
performing a factory default reset, this button is toggled off (unlit).

9. ATMN Button 

Toggling this button on (button will be lit) allows an Automation System to control the MC1-MK. 
After performing a factory default reset, this button is toggled off (unlit).

10. PGM Audio Area 

This area includes an audio fader that enables you to control the Program audio gain. The slider is 
set by default to 0 and has a range of -72 to +12dB. Use the Default button to reset the audio 
gain. You can also configure an option in the Personality tab to automatically reset the audio gain 
to 0dB after any Background transition. Refer to the MC1-MK Installation Manual for details on 
configuring the option.

11. Lock Button 

Use this button to lock the interface so that users are locked-out of the interface. This prevents 
anyone from changing settings on this MC1-MK interface. To lock the interface, select the 
button. To unlock, use the provided Unlock rotary spinner.
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Switcher Basics
This section gives an overview of how video is controlled by the MC1-MK. This includes video 
sources, video layering, and preview. For information on setting up crosspoints and video inputs, 
refer to the MC1-MK Installation Manual.

Video Sources

The MC1-MK has access to two basic types of video sources: external and internal. All video 
sources can be assigned to video source (crosspoint) buttons. By pressing a crosspoint button on a 
bus, the video source assigned to that button is selected.

• External — External video sources come from a router.

• Internal — Internal video sources come from internally generated video, such as any of 
the four internally generated Logo channels, or an internally generated black.

To select a video source on a bus, you must identify the bus you want to assign a video source to 
and then press the crosspoint button you want to select on that bus.

Video Layering

Key layering is fixed for the MC1-MK and starts with Background and proceeds to Keyer 4.

Figure 1.2  Video Layering

Video Preview

Video preview allows you to use an additional monitor to preview what the next shot is going to 
be. The Preset bus of MC1-MK shows what is selected for the next transition. This includes the 
keys and background video sources that will be on-air after the next transition.

Overlay

The overlay feature provides one layer of text, in real time, as a source for any Keyer. The text 
can be from an EAS.

Multiple MC1-MK Operation

DashBoard enables you to have multiple On Air Control interfaces open with each interface for a 
specific MC1-MK Master Control Switcher. Refer to the MC1-MK Installation Manual for 
details on setting up multiple cards.
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Keying

In This Chapter
Keying is the term used to describe when you insert (or electronically cut) portions of one screen 
into another, or place titles over background images. Keys are made up of two basic components: 
an alpha (that cuts the hole in the background video), and a fill (that fills the hole with different 
video). This chapter provides a summary of the MC1-MK keying features. 

The following topics are discussed:

• Keyers Overview

• Configuring a Key
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Keyers Overview
MC1-MK includes four high quality HD/SD-SDI video keyers. In addition to the external Key 
Video and Key Alpha source, there are also four internal static/animation playout channels. An 
excellent device for keying external devices such as character generators, graphic systems and 
EAS devices into a program feed and/or keying with four internal logo channels.

The card offers full key control with shaped and unshaped keying, self key or auto key, with clip 
and gain control. 

Figure 2.1  Keyer Controls    

1. Keyers Tab

Each keyer has a sub-tab that enables you to select video sources, key types, and adjust 
transparency, clip, and gain. The MC1-MK supports Auto Select and Self keys. The External 
sub-tab enables you to specify the router source that feeds input on BNC 2 or 4 used as the 
External source when configuring keyers.

2. Logos Tab

Each logo channel has a sub-tab in the Logos tab that enables you to specify the media files the 
channel uses. Refer to the section “Loading Media Files” on page 5-2 for details.

3. Program Keyer Select Buttons

When lit red, a button indicates that specific keyer is currently on-air on the Program bus. 
Selecting a button will immediately perform cuts on that keyer.

4. Preset Keyer Select Buttons

These buttons are used to choose which keyer is included in the next transition. Note that 
depending on a Personality tab setting, once a transition is performed, the button(s) are no longer 
lit.

1) Keyers Tab 3) Program Keyer Select Buttons

2) Logos Tab 4) Preset Keyer Select Buttons
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Configuring a Key
The MC1-MK provides the ability to associate each keyer (1-4) with the following sources: 
external key/key fill, and logo channel. This section briefly describes how to set up Key Alphas, 
Auto Keys, adjust the clip and gain values.

For More Information on...

• the Keyers menu items, refer to Table 6.2 on page 6-3.

• loading media files to logo channels, refer to the section “Loading Media Files” on 
page 5-2.

• performing transitions, refer to the section “Performing Transitions” on page 3-4.

Overview

This section outlines the key types and key alpha types supported by the MC1-MK.

Key Types

The MC1-MK supports the following key types:

• Auto Select — An Auto Select Key uses two video signals: the Key Alpha is used to cut 
the hole in the video, and the Key Video is used to fill the hole. For external keying, the 
source on BNC 2 is the Key Video and the source on BNC 4 is the Key Alpha. For 
internal sources, the Key Video and Alpha are generated internally (BNC 2 and BNC 4 
are not used). Note that the Key Alpha Type is automatically set to Shaped.

• Self — A Self Key uses only one video signal: the luminance (or brightness) of the Key 
Video is used as the Key Alpha. For external keying, the source on BNC 2 is used as the 
Key Video and the Key Alpha (BNC 4) is not used. For internal sources, the Key Video is 
internally supplied (BNC 2 nor BNC 4 are used). Note that the Key Alpha Type is 
automatically set to Unshaped.

Key Alpha Types

You can specify a key alpha as one of the following:

• Unshaped (multiplicative keying) — With an Unshaped Key, the Key Alpha luminance 
value mixes linearly the Key Video with the Background. Shades of gray, in the Key 
Alpha, are translated into transparency levels, giving the key a soft edge. Self Keys are 
set to Unshaped by default.

• Shaped (additive keying) — With a Shaped Key, the Key Alpha cuts a hole in the 
Background based on the luminance value of the Key Alpha and adds the Key Video to 
the Background hole. Shaped Key alphas are sometimes used with Character Generators 
to cut very precise holes for the Key Video fill. Auto Select keys are set to Shaped by 
default.
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Configuring Key Sources

You can assign any of the four logo channels or a router crosspoint as the source for a keyer. The 
specific router crosspoint assigned to the Key Video source can be selected using the options in 
the External tab. 

To configure a key

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard.

3. Select the Keyers tab.

4. From the Keyers tab, select the tab for the key you wish to configure.

5. From the Keyer Source area, select the button for the video source you want to assign to 
the Keyer. The button for the selected source is now lit. If you selected External, you 
may also need to specify the router crosspoint as outlined in the section “To specify a 
router crosspoint as the External Keyer source” below.

6. Toggle the Key Type button to set the Key Type to Auto Select or Self.

7. If required, toggle the Key Alpha Type button to set the Key Alpha Type to Unshaped 
or Shaped. 

8. Adjust the Clip and Gain values of the key using the corresponding sliders. 

9. Use the Transparency slider to adjust the transparency level of the key.

10. Toggle the Key Invert button to specify whether the key is inverted.

To specify a router crosspoint as the External Keyer source

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard.

3. Select the Keyers tab.

4. Select the External tab.

5. From the External Sources row, select the button for the router crosspoint you want to 
assign as the External source. The button is now lit and this crosspoint will be used 
whenever External is selected as the source for any Keyer. The crosspoint is identified 
by the default name displayed on the button in the External sub-tab. 

Note — Ross Video strongly recommends leaving Logo 4 assigned to Key 4 to 
ensure that EAS text crawls output properly.

Note — Ross Video strongly recommends leaving the Clip and Gain values at the 
default settings to avoid undesirable effects.
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Transitions

In This Chapter
This chapter provides a summary of performing transitions in DashBoard. 

The following topics are discussed:

• Transition Area

• Performing Transitions
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Transition Area
Transitions are used to change the background video and take keys on and off-air. A transition can 
include any combination of Background video, and keys. The Background A and B inputs allows 
for background dissolves and V-Fades behind the external key source. All four inputs have line 
synchronization, locked to an external analog reference, to ease system timing requirements.

Figure 3.1  Transition Area

1. Keyer Area

The Keyer Area enables you to add, or remove, keyers in transitions. This area includes the 
following controls:

• The top row of buttons, labeled Key 1-4, are used to perform cuts on the specified keyer 
directly on the Program Bus, without affecting their inclusion in the next transition. A lit 
button indicates that the specified keyer is currently on-air.

• The middle row displays thumbnails of the video source selected for that keyer when 
possible. Note that images are only provided for the internal logo sources and not for 
external router sources.

• The bottom row of buttons, labeled Key 1-4 PST, are used to add, or remove, the 
specified keyer to the next transition. Selecting the button toggles the keyer on/off and 
selects/removes the keyer to the Preset Bus respectively. Once the transition is executed, 
and depending on a Personality tab setting, the button(s) are no longer lit in this row but 
are lit red in the top row.

2. Transition Type Buttons

The following Transition Type buttons are available (from left to right):

•  — Select this button to perform a cut transition from one source to the next.

1) Keyer Area 3) Transition Speed Buttons 5) TAKE Button

2) Transition Type Buttons 4) BKGD PST Button
3–2 • Transitions MC1-MK Operation Manual (Iss. 04)



•  — Select this button to perform a V-Fade transition from the Program source to 
Black to the Preset source. The MC1-MK fades down from one source to black and then 
transitions to the next source. During a hot-punch transition, the video performs a CUT 
while the audio performs a V-Fade.

•  — Select this button to perform a cut to black, then fade up to the next source.

•  — Select this button to perform a gradual fade from one source to the next. The 
MC1-MK performs a cross fade between sources. Note that this button is selected after 
performing a factory default reset.

•  — Select this button to fade from one source to black and then cut to the next source.

3. Transition Speed Buttons

These buttons apply the rate (slow, medium, fast) to the next transition. The transition rates are 
specified in the Home tab. Note that the Slow button is selected after performing a factory 
default reset.

4. BKGD PST Button

The BKGD PST button is used to add, or remove, the BKGD from the next transition. Toggling 
this button will immediately affect the Background video that is visible on the Preset output.

5. TAKE Button

Selecting the TAKE button performs the transition between the sources selected in the Program 
and Preset buses, using the specified Transition Type and Transition Speed. These sources can 
include any of the BKGD and Keyers depending on the state of the corresponding buttons in the 
Keyers Area.
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Performing Transitions
You can perform transitions in one of the following manners: hot-punching a crosspoint on the 
Program bus, selecting a Keyer (1-4) button from the Keyer Area to transition a keyer on or off 
air, and using the options in the Transition Area to add elements to the transition.

To set the transition rate

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard.

3. Select the Home tab.

4. Specify the rate, in number of frames, as required, in the Slow Rate, Medium Rate and 
Fast Rate fields. 

5. Set the Fade to Black transition rate using the FTB Rate field.

To perform a transition

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard. 

3. In the Transition Area, select the elements you want to add to the next transition by 
selecting the BKGD PST button to add the Background video source, and the Key 1-4 
PST buttons to add the required keyer(s).

4. On the Preset bus, select the video source you want to take on-air.

5. Select a Transition Speed button (Slow, Medium, or Fast).

6. Select a Transition Type button.

7. Select Take.

To perform a Fade to Black

The FTB button allows you to fade to black, where the Program bus is faded to black at the FTB 
rate. This rate is set in the Home tab as outlined above. When the FTB button is selected, or lit, 
the MC1-MK performs an Auto transition to black.

Transition Notes

Keep the following in mind when performing transitions:

• To allow for audio cross fading, a cut takes two frames. One frame is used for the audio 
fade down, the video is then cut, followed by the one frame audio fade up.

• The speed at which the Auto transition is performed, in number of frames, is determined 
by the Transition Rate (Slow, Medium, or Fast) set in the Transition Rate area. Before 
proceeding, ensure the Transition Type is set to the desired type. When switching 
between router sources, there is an additional time after the (visible) transition, while the 
router sources are switched.

• If a crosspoint or transition button is selected while a transition is in progress, the original 
transition continues as subsequent button presses are ignored.

• Verify how the Toggle Program/Preset Bus and Disarm Preset Keyers options are 
configured in the Personality tab. Refer to the MC1-MK Installation Manual for details 
on configuring these options.
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Audio

In This Chapter
This chapter provides a summary of the audio features. 

The following topics are discussed:

• Audio Features

• Audio Transitions
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Audio Features
This section briefly summarizes the audio monitoring and controls available in the On Air 
Control interface for the MC1-MK.

Figure 4.1  On Air Control Interface — Audio

1. Audio Meters

This area displays Preset and Program audio peak level measurements for eight channels. The 
first eight channels of each bus (Preset and Program) are metered. Measurement units are in dBFS 
(decibel full scale) where 0dBFS is the maximum digital value. Each audio meter displays audio 
level information as illustrated in Figure 4.2.

Figure 4.2  Illustrative Example of Audio Level Information

2. Audio Fader Controls

Use the slider to apply an audio gain value on the Program and Preset bus. The gain range is 
-72dB to +12dB. Use the Reset Audio Gain button to set the gain value to 0.

1) Audio Meters 2) Audio Fader Controls

0.00 dBFS
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-11.75
-14.50
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-20.00
-24.00
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Audio Transitions
The MC1-MK processes embedded audio on all four inputs. You can specify which audio groups 
present on the inputs are carried through to the outputs (by default all groups are included). 
During transitions, the audio ramps smoothly between Program and Preset sources, matching the 
video transition.

To set the Master Audio level

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard.

3. Specify the audio gain value using the Audio Gain slider. The numerical gain value may 
also be entered directly next to the PGM Audio field. You can select the Reset Audio 
Gain button to set the audio gain to 0dB, the factory default value.

Performing Transitions

Keep the following in mind when performing transitions:

• A two-frame V-Fade is performed on the audio if a different source is hot-punched on the 
Program bus.

• Audio transitions are Mix or V-Fade (on video fade, and cuts). However, during Cut 
transitions, the audio transition is a V-Fade.

• The MC1-MK allows A/B audio mix on 16 channels between Program and Preset bus.

• Depending on how the Reset Audio Gain feature is configured, the audio gain level may 
be reset to 0dB after a transition. Refer to the MC1-MK Installation Manual for details.

For More Information on...

• performing transitions, refer to the section “Transition Notes” on page 3-4.

EAS Audio

The MC1-MK supports embedding Emergency Alert (EAS) audio using an embedded audio 
source from BNC 4 on the rear module.

• Sixteen channels of audio are passed for AES in a stream.

• When EAS is active, all audio channels on the Program shall be adjusted by a value 
specified on the Audio tab. The default is to reduce the gain by 10dB.

• EAS audio will be mixed into the Program path on the stage just before the final fade to 
silence.

• When using a Sage Digital ENDEC EAS, the MC1-MK reacts to the Sage Push To Talk 
(PTT) relay closure to activate audio voice over. While the PTT relay is closed, the 
MC1-MK applies the EAS Duck Level specified on the Audio tab to the incoming 
Program audio and performs a cut transition by mixing the incoming audio from the Key 
Alpha channel at full level.
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Media File Management

In This Chapter
DashBoard enables you to select and configure the four Logo channels in the MC1-MK. Each 
Logo channel has a sub-tab that enables you to assign a media file to the specified logo channel, 
view a thumbnail that represents the media file currently loaded, and adjust on-air properties. 
This chapter provides information on managing the images and animations using the DashBoard 
options available for the MC1-MK. 

The following topics are discussed:

• Loading Media Files

• Managing Media Files

• Adjusting On-Air Properties

• Displaying Timecode in a Logo Channel
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Loading Media Files
The MC1-MK features four Logo channels (Logos 1-4) into which you can load files from the 
CompactFlash® Card physically installed on the MC1-MK. Each card has 2GB of DDR playout 
memory. Table 5.1 lists an estimation of how many uncompressed frames can fit into the playout 
memory of the MC1-MK.

Loading a Media File

From the Directory menu in the each Logo sub-tab, files may be loaded from the following:

• [PATTERNS] — A virtual directory containing timecode overlays and EAS text crawls. 
Refer to the section “To display timecode in a logo channel” on page 5-7 for 
information on loading timecode files.

• [RAM CACHE] — A virtual directory that displays media files that are already loaded 
in the playout memory. Selecting this directory enables you to quickly access a 
pre-loaded file from the memory.

• [ROOT] — This is the default directory and represents the top-most directory on the 
CompactFlash® Card. You can manage files on the CompactFlash Card using an FTP 
connection. Refer to the section “Managing Media Files” on page 5-3 for details.

• ross — Refer to the MC1-MK Installation Guide for information on managing the icon 
images used by the Tree View node, Home tab, Channel Select buttons, and On Air 
Controls node for your MC1-MK.

• User created directories — A list of user-created directories using an FTP connection.

To load a media file into a Logo channel

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard.

3. Select the Logos tab, then select the Logo sub-tab for the logo channel you want to load 
the media file for.

4. If files were added or re-named using an FTP connection, select Rescan to update the 
list of directories and filenames.

5. From the Directory menu, select the directory you wish to load a file from. When 
changing directories, it may take a few moments for the Filename list to be updated.

6. From the Filename menu, select the file. You can clear the Logo channel by selecting 
[NONE] from the Filename menu.

Table 5.1  Full Frame Animation 

Format Image Size No Alpha With Alpha

1080i 1920x1080 388 256

720p 1280x720 872 580

PAL 720x576 1940 1292

NTSC 720x486 2300 1532

Note — Very large animations may take several minutes to load.
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Managing Media Files
Media files, such as animations and still images, can be transferred to and from the CompactFlash 
Card using an FTP connection. Once transferred to the CompactFlash Card, you use the options 
in the Logos tab to load the files and assign them to a Logo channel. This section outlines the 
specifications for media files and provides general information on using the CompactFlash Card 
and an FTP connection.

For More Information on...

• assigning media files to Logo channels, refer to the section “Loading a Media File” on 
page 5-2.

Media File Notes

The following tips and restrictions apply when managing your media files:

• Media files, such as stills and animations, are transferred to and from the MC1-MK using 
FTP protocol. The media files are stored on a CompactFlash card that is installed on the 
MC1-MK.

• If you select an image size that is larger than the current video format, only a portion of 
the image will be visible.

• When a media file is loaded, metadata, such as X/Y position, is also loaded, if it exists. 
Otherwise, default values are used. For animations, parameters are recalled after the last 
frame is loaded. Metadata is stored with the image on the CompactFlash Card, and is 
therefore no affected by loading factory default values.

• When using Mac OS X™ to transfer files to the CompactFlash Card via an FTP server, 
you may only have read-only access. Refer to your Mac OS X™ documentation for 
details.

Image Specifications

Media files used on the MC1-MK must meet the specifications outlined in Table 5.2.

For More Information on...

• the specifications for the files located in the ross directory, refer to the MC1-MK 
Installation Manual.

Table 5.2  Media File Specifications

Parameter Specification

File Type BMP, GIF, JPEG, PNG, TGA

Compression compressed and uncompressed

Interlaced formats (1080i, 480i, 576i)
Max. Image Width: 32,768 pixels

Max. Image Height: dependent on available memory

Progressive formats (720p)
Max. Image Width: 65,536 pixels

Max. Image Height: dependent on available memory

Animation Maximum Length 10,000 frames
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File Naming Specifications

The name can contain letters, numbers, and spaces, but cannot contain symbols such as ! @ # & * 
( ) ? / , ‘ “.

Animation consist of multiple files, each must be numbered in the sequence that it will play out. 
The following restrictions apply to file names for animations:

• Each file can use a minimum 3-digit number, including all the leading zeros. The 
numbering can start from any value.

• The file name must consist of: the characters that are constant for this animation 
sequence, followed by an underscore (_), followed by three or more digits, followed by a 
period, followed by the filename extension.

• Each file in the sequence must have the same numbering scheme.

• Files are loaded in numerical order.

The following is an example of a 10-frame animation using a typical numbering scheme:

• DTVB_000.tga

• DTVB_001.tga

• ...

• DTVB_009.tga

Connection using FTP

You can use an FTP connection to transfer media files to and from the CompactFlash Card of the 
MC1-MK. You can also use an FTP client to delete images on the CompactFlash Card and 
re-name images.

To access the MC1-MK via FTP

• Have the IP address from Config > Ethernet.

• Ensure an ethernet cable is connected to the MC1-MK rear module. Refer to the 
MC1-MK Installation Manual for connection details.

An FTP connection to the MC1-MK should be established by your IT department. The following 
information is required to create an FTP connection:

• User Name — user

• Password — password

Connection using RossLinq™

RossLinq enables you to transfer still images directly from the XPression™ to a MC1-MK Logo 
channel. You can transfer files into any of the directories for any of the Logo channels on the 
card. There are four directories, each corresponding to a specific Logo channel on the card. The 
file can be a format as listed in Table 5.2. Note that the transfer of animations is not supported at 
this time. 

Note — The RossLinq™ channel in XPression must be set as a passive FTP 
connection in order to set up communications between XPression and the MC1-MK. 
Refer to the XPression documentation for details.
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To connect to the XPression via RossLinq, establish an FTP connection using the following 
information:

• IP Address — Refer to the Ethernet tab in the MC1-MK Configuration interface.

• User Name — xpression

• Password — password

CompactFlash® Card

The following tips and restrictions apply when using the CompactFlash Card:

• the CompactFlash Card must be installed on the MC1-MK before the board powers up 
and must remain inserted.

• if you wish to remove the CompactFlash Card for programming, you must re-boot the 
MC1-MK when you re-install the CompactFlash Card. This allows the MC1-MK to 
recognize that a new CompactFlash Card is available.

• the CompactFlash Card is 2GB in size, the number of files you can store depends on the 
type of file (PNG, TGA, JPG). The CompactFlash Status field in the Hardware tab 
displays how much space is available on the CompactFlash Card.

• refer to the MC1-MK Release Notes for information on formatting the CompactFlash.

Note — If using an EAS, Logo 4 channel is automatically reserved for the EAS use 
and you should not attempt to transfer files via RossLinq into Logo channel 4.
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Adjusting On-Air Properties
The Logos tab in DashBoard allows you to adjust the position and play modes of media files. The 
following features are supported:

• Auto Play — When set, the animation will play from the first frame when it is brought to 
air. When clear, bringing the animation to air does not affect playback.

• Looping — When set, the animation will cycle continuously (from the last frame back to 
the first) in an endless loop. When cleared, the animation plays once, and freezes on the 
last frame.

For More Information on...

• the Logos menu items, refer to Table 6.3 on page 6-5.

To adjust the on-air properties of a media file

1. Load a media file as outlined in the section “Loading a Media File” on page 5-2.

2. Adjust the position of a still image in the viewing area of the screen using the X and Y 
Position sliders.

3. Adjust the characteristics of an animation using the Auto Play and Looping boxes.

4. Select how an image is displayed by selecting an option from the Play Mode menu. 

Note — The Play Mode feature only applies to Interlaced video formats and has no 
effect when using Progressive video formats.
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Displaying Timecode in a Logo Channel
The Logos and Keyers tabs in DashBoard enable you to assign an LTC input to a Logo channel, 
then assign that Logo channel to an output. This section summarizes the steps required to 
configure an output to display LTC text, and provides additional configuration information.

Overview

The timecode information displays on-screen in one of the following formats: 

Frame Count Range

The frame count range depends on the video format you are using:

• When using 480i 59.94Hz and 1080i 59.94Hz, the range is from 00 to 29.

• When using 576i 50Hz and 1080i 50Hz, the range is from 00 to 24.

• When using 1080pSF 23.98Hz and 1080pSF 24Hz, the range is from 00 to 23.

• When using 720p 50Hz, the range is from 00 to 49.

• When using 720p 59.94Hz, the range is from 00 to 59. 

To display timecode in a logo channel

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard.

3. Select the Logos tab.

4. Select the sub-tab for the Logo channel you want to load the timecode file for.

5. Select a timecode file to load to the Logo channel as follows:

• From the Directory menu, select [PATTERNS].

• From the Filename menu, specify the display font size (e.g. Select Time code - 
small to display text in a small font size).

6. Select the Keyers tab.

7. Select the sub-tab for the Keyer you wish to use to display timecode.

8. Adjust the transparency and other on-air properties for the output as described in the 
section “Configuring a Key” on page 2-3. It is recommended to set the Key Type to 
Auto Select and the Key Alpha to Unshaped. 

9. From the Keyer Source area, select the Logo channel to assign it to the output.

--:--:--:-- This format is used when no LTC input signal is received.

HH:MM:SS:FF
This is the standard format. The timecode is displayed in Hours, 
Minutes, Seconds, and Frames. The drop-frames is not active.

HH:MM:SS;FF
This is the drop-frame format. The timecode is displayed in Hours, 
Minutes, Seconds, and Frames. The drop-frame is active.

Note — When using a progressive video format, the LTC standard only provides a 
count of every second frame, but the MC1-MK will increment and display the frame 
count on every frame.
MC1-MK Operation Manual (Iss. 04) Media File Management • 5–7



10. From the On Air Control interface, enable the Keyer which was configured in the 
previous steps.

11. To adjust the on-screen position of the timecode, return to the Logos tab and use the X 
and Y Position sliders.

Configuration Notes

Keep the following in mind when configuring a Logo channel for displaying LTC on-screen:

• The Status field on the Logos tab indicates the dimensions of the timecode file in the 
number of pixels. Note that this value changes depending on the video format you are 
using.

• To assign the same LTC to multiple outputs, configure a Logo channel with the LTC and 
then assign that Logo channel to multiple key sources. 

For example, to assign LTC to the Logo 3 channel and then assign it to multiple outputs:

› Configure Logo 3 to display LTC.

› Select Logo 3 as the Keyer Source box for Key 1, Key 2, Key 3, and Key 4.

• Should you attempt to load the same LTC to a second Logo channel, an error occurs and 
a message is displayed in the Status field of the second Logos tab. 

• You can transition between the keys, or the Background when using an MC1-MK. This 
can be used to transition the LTC on and off air.
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Appendix A. DashBoard Menus

In This Appendix
This appendix briefly summarizes the menus, items, and parameters available from the 
DashBoard Control System™ for the MC1-MK. Default values are noted with an asterisk (*). 

The following topics are discussed:

• Home Tab

• Keyers Tabs

• Logos Tabs      

Note — Before proceeding, ensure that you are running DashBoard software 
version 5.0.0 or higher. The DashBoard Control System software and user manual 
are available to download from the Ross Video website.
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Home Tab
Table 6.1 summarizes the Home tab options available in DashBoard.

 
Table 6.1  Home Tab Options

Menu Title Item Parameters Description

Transition 
Rates

Slow Rate 1 to 999a

a. The default value is 60 frames (2 seconds) when using 59.94Hz formats. When using 50Hz formats, the default value is 50 frames.

Defines the Slow Rate in frames

Medium Rate 1 to 999b

b. The default value is 30 frames (1 second) when using 59.94Hz formats. When using 50Hz formats, the default value is 25 frames.

Defines the Medium Rate in frames

Fast Rate 1 to 999c

c. The default value is 15 frames (0.5 second) when using 59.94Hz formats. When using 50Hz formats, the default value is 12 frames.

Defines the Fast Rate in frames

FTB Rate 1 to 999d

d. The default value is 30 frames (1 second) when using 59.94Hz formats. When using 50Hz formats, the default value is 25 frames.

Defines the Fade to Black Rate in frames

Station Logo 
image

Displays an image of the station logo (using 
the file: station_logo_large.png)

EAS Status:
ONe

e. Followed by color-coded text.

Indicates that an installed EAS is providing 
content to the MC1-MK text overlay; the text 
is displayed in this area when the EAS is 
active.

OFF
Indicates that EAS content is not provided to 
the MC1-MK text overlay
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Keyers Tabs
Table 6.2 summarizes the Keyers tab options available in DashBoard. Each key has a sub-tab to 
select which key is to be modified.

Table 6.2  Keyers Tab Items

Tab Title Item Parameters Description

Key #

Transparency 0* to 100

Adjusts the transparency level of the key:

• 0 — The key is completely opaque; there is no 
difference between the original key and the key with the 
transparency effect applied to it.

• 100 — The key is completely transparent; the key is not 
visible on the screen.

Clip #
Adjusts the clip values; default is 92% (the maximum 
luminance range not including Super White).

Gain 0 to 100 Adjusts the gain values; default is 50.

Key Type

Auto Select* 

A Key which uses two video signals (Alpha and Fill); the 
Key Alpha Type is automatically set to Shaped. For 
external key source, the source on BNC 2 is assigned as 
the Key Video and the source on BNC 4 is the Key Alpha. 

If you configure an internal Logo channel as Auto Select, 
the associated alpha (not BNC 2 or BNC 4) signal is used.

Self

A Key that uses the luminance values of the key source 
for the alpha; the Key Alpha Type is automatically set to 
Unshaped.

When using an external key source, the source on BNC 2 
is assigned as the Key Video, and its own luminance as 
the Key Alpha.

If you configure an internal Logo channel as Self, the 
luminance value of the associated alpha is used.

Key Alpha Type

Unshaped

The card performs a multiplicative key. The Key Alpha 
luminance value mixes linearly the Key Video with the 
Background. Shades of gray, in the Key Alpha, are 
translated into transparency levels, giving the key a soft 
edge.

Shaped*

The card performs an additive key. The Key Alpha cuts a 
hole in the BKGD and the Key Video is added to the 
BKGD. Shaped Key alphas are sometimes used with 
Character Generators to cut very precise holes for the Key 
Video fill.

Key Invert
On

Reverses the polarity of the Key Alpha. A Key Invert can 
be applied to any key type.

Off* The Key Alpha is not inverted

Default Make Linear Resets the clip and gain values to the default settings

Keyer Sourcea
External Assigns the external key source as the keyer output 

Logo #b Assigns the selected Logo media file as the keyer output
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External
#

Selecting a button specifies that router source as the 
External source; a lit button indicates that the source is 
being used as the External.

The default External Source for the External Key is the 
first unshifted router source.

Shift Select this to shift the sources

a. The default Keyer Source is as follows: Key 1 is Logo 1; Key 2 is Logo 2; Key 3 is Logo 3; Key 4 is Logo 4.
b. When using an EAS device, Logo 4 is automatically assigned to Key 4 for EAS text crawls.

Table 6.2  Keyers Tab Items

Tab Title Item Parameters Description
6–4 • Appendix A. DashBoard Menus MC1-MK Operation Manual (Iss. 04)



Logos Tabs
Table 6.3 summarizes the Logos tab options available in DashBoard. Each logo has a sub-tab to 
select which logo is to be modified.

Table 6.3  Logos Tab Options

Tab Title Item Parameters Description

Logo #

Video Image Displays a thumbnail image

• Displays a small image that represents the 
currently loaded media file. For animations, 
the fifth frame is displayed.

• Only available when the card ethernet port is 
connected and properly configured

• A black box with text indicates that no image 
is currently loaded

Alpha Image Displays a thumbnail image

• Displays a small image that represents the 
Alpha channel of the currently loaded media 
file. For animations, the fifth frame is 
displayed.

• A blank area indicates that the current image 
has no alpha channel

File (read-only) xxx_####.yyy

• Indicates the full path of the currently loaded 
file where:

• xxx represents the file path

• #### represents the duration of the file if it is 
an animation

• yyy represents the file extension

Status (read-only)

Loading frame X of Y • Displays information about the channel in 
both the number of frames (integer), and in 
the number of seconds (fractional)

• Any errors during loading are also displayed

• When the file(s) have loaded, this field 
displays the dimensions of the image (e.g. 
1920x1080)

Animation loaded (#)

Single image loaded (#)

Idle

Selected on 
(read-only)

### Indicates all the key(s), or backgrounds, that 
currently have the media file selected None

On Air (read-only) ###
Indicates the on-air key(s), or backgrounds, 
that have this media file selected

Directory

[PATTERNS]
Provides a list of virtual files loaded in the card 
memory, such as timecode information

[RAM CACHE] • The field displays the directory the currently 
selected media file is located in

• Provides a list of all of the directories on the 
CompactFlash card

[ROOT]*

ross
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Logo #

Filename

#

• Displays the name of the currently selected 
media file

• Animation filenames include an underscore 
followed by three or more digits. The number 
of frames, and duration in seconds, is 
displayed in brackets after the filename.

• Updated when a new Directory is selected in 
the Directory menu

• Provides a list of all the media files in the 
currently selected directory. Note that 
animations appear as a single entry.

[NONE]

Selecting this option clears the logo channel. 

This item is automatically selected, without 
clearing the channel, when the user switches to 
a new directory.

File List Rescan

Pressing the button:

• updates the Directory menu options

• updates the Filename menu options

X Positiona ## to ##b

• Adjusts the position of the image along the 
X-axis in number of pixels

• The range varies depending on the output 
video format

Y Position ## to ##b

• Adjusts the position of the image along the 
Y-axis in number of pixels

• The range varies depending on the output 
video format

Auto Playc

Selected*
The animation automatically starts to play 
when it is taken on-air.

Cleared
The animation starts playing as soon as the 
animation is loaded to the bus

Loopingd

Selected*
The animation starts over when it reaches the 
last frame of the animation

Cleared
The animation stops when it reaches the last 
frame of the animation

Play Mode

Normal* The entire frame of the image is displayed

Swap Fields
Field 1 and Field 2 of the image are swapped 
when they are displayed

Field 1 Only Field 1 of the image is displayed

Field 2 Only Field 2 of the image is displayed

a. These settings only apply when there is an image loaded in the Logo channel. When the Logo channel is empty, these settings have no 
effect.

b. Default value is 0 which represents the top-left corner of the active picture area.
c. This option is only applicable when an animation file is selected.
d. This option is only applicable when an animation file is selected.

Table 6.3  Logos Tab Options

Tab Title Item Parameters Description
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Contact Us

Contact our friendly and professional support representatives for the following:

• Name and address of your local dealer

• Product information and pricing

• Technical support

• Upcoming trade show information

Visit Us

Visit our website for:

• Company information and news

• Related products and full product lines

• Online catalog

• Testimonials

Technical        
Support

Telephone: +1 613 • 652 • 4886

After Hours Emergency: +1 613 • 349 • 0006

Email: techsupport@rossvideo.com

General     
Information

Telephone: +1 613 • 652 • 4886

Fax: +1 613 • 652 • 4425

Email: solutions@rossvideo.com

Website: http://www.rossvideo.com
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